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Introduction

The TransEdit Transcription utility described in these instructions has been designed to be as user friendly and yet still be as configurable as possible. TransEdit makes broad use of the ‘point and click’ capabilities inherent in the Microsoft Windows 98/NT operating systems.  It does this to avoid the most common of errors which experience has taught are those in the annotation of the special conventions denoting noises and other anomalies occurring in the recording of ‘real world’ speech data.  Time marking and turn segmentation are also facilitated through the use of mouse movements and clicks as opposed to complicated typing and manual correlations.

Due to the fact that it is a stand-alone executable file, it makes no changes to the system registry and there are no installation routines.  The only thing the user is required to do to begin using TransEdit is to create an annotation system and write a menu (‘.mnu’) file using the editor built into TransEdit for this purpose.  

TransEdit will load and play a wide variety of audio formats and it will display the audio files as lines or blobs, which is selectable through a pull down menu on the toolbar.

These instructions are written with the assumption that the user has at least a working knowledge of the Microsoft Windows desktop operation and configuration.  Tasks such as folder creation, shortcut creation, etc. are fully explained in the ‘Help’ available through the Start menu.  There was no need seen to reiterate what is already available and adequately explained.

Features

TransEdit is a unique piece of software that contains many features that have been lacking in many previously released transcription tools. This section will cover the menu options available on the very standard appearing menu bar.   Through familiarization and use the user will see that this program is the most useful to date for the transcription of speech data for research purposes. 

The first menu item is of course the ‘File’ menu.  It is very much like any other Windows text editor except for the two features unique to TransEdit.  These are the ‘Add Wavefile’ and ‘Load Marker File.’  The functions of these will be furnished later in these instructions.
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‘Add Wavefile’ is used to load the audio file(s) that is/are to be transcribed.

‘Load Marker File’ is used to load a marker file that is not the one associated with the current transcription (trl) file.

The second item is the ‘Edit’ option.  The bottom four options are those that are unique to TransEdit.  The ‘Speaker List,’ ‘User Labels,’ ‘Change Header,’ and ‘Repair Turn Numbers.’
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‘Speaker List’ is used to list the speakers involved in the dialog or speech of the audio file being transcribed currently.

‘User Labels’ is used to create a list or lists of user labels for instances that are unique to the current transcription task, but are not deemed to be of such usual use to be included in the normal Label file.

“Change Header’ is used to edit the header data of the transcription file.

“Repair Turn Numbers’ is used to recount the turn numbers in the transcript (.trl) file and number them correctly in order from ‘000’ to whatever.  This command works whether or not there is a marker file loaded.

‘Labels’ is the third item in the menu bar.  It comprises of only two items, ‘Load Labels’ and ‘User Labels’
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‘Load Labels’ is used to enable the user to load for use a previously written ‘.mnu’ file that contains the annotation tags and the conventions for use in the transcript.  The ‘Label’ file will produce a combination of combination of buttons and pull down menu under this heading for the easy insertion of tags into the text.

‘User Labels’ will allow the user to insert those tags only of interest in the current transcription.

 ‘Options’ is the next selection and as of this writing only the ‘Wave Display’ has been enabled.
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When clicking on ‘Wave Display’ the following window appears which allows the user to alter the visual parameters of the wave display.  These are fairly self-explanatory, but note must be taken that each speaker has his own color when segmented in the audio wave.  This makes it very easy to visually scan the audio wave for when a particular speaker is active after transcription is completed.
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‘Advanced’ is the next option.  It consists of two selections: ‘Menu Editor’ and ‘Convert.’
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‘Menu Editor’ is used to bring up the window with which one can create .mnu files that consist of the parameters for tags for anomalies within the speech segments, either human or non-human.

‘Convert’ is used at this time to convert CMU style turn naming and numbering to Verbmobil style and vice versa. 

· CMU:   
Filename_Channel-ID_TurnNumber_Speaker-ID_0000:

· VERBMOBIL:
filenameChannel-ID_TurnNumber_Speaker-ID_00000000:

In the future an option will be added to support more individual styles.

It should be noted that ‘Advanced’ is a special mode that must be selected from the ‘View’ menu, which will be described next.

‘View’ is the next menu available on TransEdit.  It has several options available as to which items can be displayed.  As with many other Windows applications all the user has to do is to experiment and then to pick and choose the items with which he or she feels more comfortable. Included in this menu are the options for display of the waveform and the switch to and from the advanced mode.  It is recommended that the ‘Advanced’ mode only be used when necessary. 
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Installation
TransEdit, being just a simple executable file, can be placed virtually anywhere in the PC to include the desktop. However, it is recommended that the user create a folder under program files called ‘TransEdit’ and use a shortcut on the Windows desktop to access the executable.  This is due to need for creation of various menu files for transcription conventions, which makes for easier record keeping.

Setup

After opening the TransEdit a window that looks like this should appear:
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This is the basic TransEdit window.  Which as can be seen consists of a standard Windows toolbar, a white area that is for text, and a black area that is where the audio file(s) will be displayed.  As can be seen in this graphic the Transedit program has a great many of its features readily displayed on the toolbar.

If no annotation conventions were supplied with this copy of TransEdit then a ‘menu’ file (.mnu) must be created for the specific needs at hand. This menu file will give the transcriber ‘push button’ access to all conventions necessary to complete the assigned task.  Also if the user needs to add a special convention to be used only for this single task or to insert a special ‘flag’ to identify particular aspects for whatever reason there is also an option to create ‘user defined’ labels.

The first step in the creation of a menu file is to change the usage mode to ‘Advanced’.  Clicking on the view menu and selecting ‘Advanced’ as in the following illustration do this.
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After ‘Advanced Mode’ is selected a message will appear asking if the user is ‘sure’.
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After entering ‘Advanced Mode’ it is necessary to start the ‘Menu Editor’. Clicking on ‘Advanced’ on the toolbar and selecting ‘Menu Editor’ does this.
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(Next Page)

The following Window will appear:
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This is a very versatile editor in that it allows the user to create not only buttons that will appear on the toolbar, but also enables the user to create a pull down menu that contains the convention tags in a category tree for easy access.  The user is fully able to create the button set and the pull down menu, or either the button set or the pull down menu.  It is wholly up to the user, but only one 

The simplest thing to do is to create the buttons for the toolbar.  In the bottom window of the editor, which is appropriately named ‘Buttons’ all the user does, is, in the box labeled ‘D’ type in the convention tag to be added and click ‘Add’.  It will appear in the large box at the bottom ‘E’. 

After all the desired tags have been entered, all the user does is hit the ‘Save as’ button at the bottom and type the appropriate filename in the box, making sure that the ‘Save as file type’ selected is ‘Menu Files.’ 
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The system of file naming is totally left to the user.  The only stipulation is that it uses the ‘.mnu’ file extension, and contain only one ‘.’ (Dot) except in the case of the ‘foo.trl.set’ file that is created by TransEdit for header data, which will be explained later.  

The next few lines will deal with the creation of the pull down menu.  It will first be covered as though it were the first thing being done.  How to add buttons to a pull down menu or vice versa will be covered afterwards.

To create the pull down menu addition to the toolbar is a little more complicated but not all that difficult.  It is probably easier done than explained, but an explanation will be attempted.  

The first step is for the user to decide how to arrange the menu. Once this is done the actual creation of it is fairly straightforward.
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The first thing to be done is to enter the first category heading in box ‘A’ then click ‘Add’ and it will appear in box ‘B.’   

The next thing to do is to highlight the category name in window ‘B.’ Then type all the labels that fit this category in one at a time in box ‘C’ and they will appear in box ‘F’ following the click on the appropriate ‘Add’ button.  To add a new category all that is required is to enter a new category in box ‘A,’ add it and highlight it.  After highlighting the new category, Box ‘F’ will be blank to show that nothing is entered for that heading.  Labels for that heading are then added as for the first. 
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The file is then saved as in the first example.

To add a pull down menu or buttons or just to edit a menu file in any way all the user does is click on the button marked ‘Load’ and select the desired file as one would any file in any other windows application.  After performing the desired additions or alterations, the user then can save the file in the manner previously described.

There are a few special characters to define additional functionality of the buttons. These functions are e.g. setting the cursor position after inserting the label or to define where to put the selected word within the inserted label (wrapping labels around words). The special characters are not shown on the label/button text. These special characters are:

· …
Defines where to put the selected word when inserting the label. If no word is selected, the word left to the cursor-position is automatically marked.  e.g. -/…/-  will place the selected word between the slashes.

· .|. 
Defines where to put the cursor after inserting the label. e.g. <!_|_> will place the cursor between the underscores.

· .#.
Restricts the label to be added only on the end or only at the beginning of a word. To define this functionality this special character must be at the end or at the beginning of the label text. e.g. .#.<_T>  will cause <_T> to be placed after the selected word.

· *
By default the labels are inserted if only one word is selected. If the label begins with a ‘*’ it allows that it may be inserted if more than one word is selected. e.g.  *+/…/+ will cause all selected words to be placed within the slashes. 

Operation

Now that the menu file is created, or menu files are already in existence, the user can now begin to actually transcribe data.  The first step in the transcription of data is to create the text (or ‘.trl’ file) ‘.trl’ is the filename extension TransEdit assigns to the actual transcript file (trl is an abbreviation for ‘transliteration’).  TransEdit also creates additional files for each transcription file.  The files are explained below:


foo.trl 


the actual transcript file in ascii text

foo.trl.set
this small file contains the header data for the transcript file

foo.mar
this is the ‘marker’ file which contains the time marks for the segmentation of the audio.  TransEdit performs absolutely no alterations to the audio file itself.

foo.spk
this file contains the speaker name data for the speakers in the current transcript

***WARNING***

It is very important for the successful operation of TransEdit that no filenames are changed until after the complete processing of a file set.  This is due to the fact that when a user opens a TransEdit .trl file the program will look for its corresponding .trl.set file and its corresponding .mar file.  If it does not find them it will either go into a continuous loop exhausting sytem resources or will simply just lock up the machine. 

**********

NOTE

Transedit will read audio files over a network, but it is highly recommended that all TransEdit specific files, such as trl, mar, spk, nos, etc., be maintained on the machine is being used as the work platform as TransEdit’s ‘Autosave’ feature does not yet work over a network connection.

To begin transcribing it is necessary, of course, for the user to open TransEdit.  A window will appear that is identical to the one in the very first illustration in these instructions.  Experience in testing has shown that the best way for a user to start is by creating the filename of this new transcription by doing a ‘Save As.’ When the user does the ‘Save As’ determining the location for the storage of the transcript file a small window will appear in which the header data can be entered. Once again it is important to watch the file type under which the file is being saved
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In this header the user would enter the filename, the name of the transcriber, and any comments the user desires.  After the user clicks ‘OK’ the header data will be save in a separate file called for example ‘foo.trl.set’. The header data will also appear as comment lines at the top of the transcript in the main TransEdit window where they can be edited by using the ‘Change Header’ option under the ‘Edit’ menu on the Menu Bar. 
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The next few steps can be done in virtually any order the user desires.  The order in which they are presented here is the order a few of the testers felt was most appropriate for them.  

The next step is to open the Wavefile.  As in this illustration it is a fairly simple procedure.  Just a point and a click. 
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After the Wavefile has been selected the user will be presented with a window such as the one in the illustration below.

[image: image20.png][ADC Import Filter

Header Fomat Sanple Rate T
ke  Steres C aom =
€ CMU (ol formal) & Moro ¢ o
€ Phone dat 16000

220
€ ST 1024 e e
(® [BERD 3B fist
© fpo Headet € MsBlast Sample Size
€ fired Sie: pe ® o
@ puoDetect | | @ 16bk

Fil: CAm2\foo.ade





As can be seen there are a great many options available as to the audio format that can be used with TransEdit.

The user simply selects the options that correlate to the format of the audio file and just clicks on ‘OK’.  After the Wavefile loads the TransEdit window will appear like this:
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****WARNING****

It is always important that when opening a previously used file that the ‘foo.trl’ file be opened first. After which one opens the Wavefile.

************

Note also that TransEdit will allow the user to load as many Wavefiles as the system resources will permit.

The next step in the process is to load the label file that is the type of file that was created at the outset.

Just click on ‘Labels’ on the tool bar, select ‘Load Labels’ and select the desired ‘.mnu’ file.
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After the Label file has been loaded the toolbar will have the following appearance:
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Each button, when pressed, will cause that particular tag to be entered into the transcript thereby greatly reducing the number of typographical errors that are so time consuming to correct.

As for the pull down menu with categorized tags that was covered in the Label file creation phase file, this is what it will appear as:
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Please note that the buttons are still there and are fully functional, but the pull down menu is an aid should the user not exactly recall the type of tag needed, but only the category.

The other type of label is the ‘User Label’ and it is usually task specific or it would have been included in the primary Label file.

User labels are defined by selecting ‘User Labels’ on the edit menu:
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Another method is by clicking on the toolbar button marked ‘Edit User Labels’. Either way will result in this window being displayed.
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The user just types the desired label in box ‘A’, clicks ‘Add’ and it appears in box ‘B’ From here it can be saved and other ‘User Label’ files can be loaded.  ‘User Label’ files all have a ‘.nos’ file extension.

Once ‘User Labels’ are loaded the can be accessed through the ‘Labels’ option on the toolbar.
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The next item to be done is set up the speaker data for identification of turns within the dialog. This is done either through the ‘Speaker List’ command on the Edit menu on the toolbar or by using the ‘Edit Speakers’ button on the toolbar.  Either on will yield the following window.
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The use of this window is fairly straightforward.  Enter the ‘Filename’, the ‘Channel’ (useful for stereo or multi-track recordings), and then the ‘Speaker.’ After which all that is necessary is to click on ‘Add’ and it will appear in the large box below.  From there the speaker information can be saved (with the ‘.spk’ extension) or the necessary speaker file can be loaded for use.

Once loaded buttons will appear on the toolbar identifying each individual speaker in the file.
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The user is now fully prepared to begin to transcribe the Wavefile.  All that is necessary is to place the red cursor of the Wavefile at a point where the transcriber wishes to begin listening and then dragging it to the right which causes an area to be highlighted (much as highlighting text in a word processing program).  When the left mouse button is released the audio in the highlighted portion will begin to play.  
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Once the transcriber has decided that a proper amount of audio data has been highlighted to satisfy the needs of the transcription task (utterance, phrase, segment, etc), and the speaker has been recognized, the user will place the mouse pointer in the highlighted area and ‘drag’ it into the gray bar above the audio wave by pressing and holding the left mouse button.  When the mouse button is released in the gray bar, the following window will appear.
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The user will then select the appropriate speaker name by clicking on it, then clicking ‘OK.’ This will cause the audio wave to be ‘segmented’ (no changes are being made to the audio at all). 

The segment label will have the speaker name as well as the turn number.
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To get this information into the text of the transcript all the user has to do is click the button on the toolbar corresponding to this speaker.
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The speaker name along with the appropriate turn number will appear in the text.  All the user must do is to type in the appropriate speech using any necessary tags.

A very good example of this is to continue on add the next segment to the transcript.

The user just highlights and repeats the previous steps but uses the other speaker name instead to show that TransEdit really does work in the prescribed manner.
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Should for some reason the turn numbers become out of order or should some numbers be missing from the text window, all the user need do is click on ‘Edit’ on the toolbar and use the command ‘Repair Turn Numbers.’
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This command reassigns numbers to the turns so there are no skipped numbers and that the turns are in precise numerical order. This is regardless of whether a marker file is loaded or not.
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